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Revision History 

Revision Date Description 
F.0 4 April 2023 Updated for the release of Oncomine Myeloid Assay GX v2 ADF 4.3.2. 

The following issues are fixed in the 4.3.2 ADF. 
• 23586. For the Oncomine™ Myeloid v2 - GX5 - DNA and Fusions - w4.2.2 

assay, Purification QC was not included by default. 
• 23818. Gene symbol correction for C11orf88. 

E.0 3 June 2022 Updated for Genexus™ Software release notes for Genexus™ Software 6.6.2.1 
The following issues are fixed in Genexus™ Software 6.6.2.1 
• 28040. Security vulnerability . 
• 24649. Unresponsive system after data backup. 
• 26086. Raw data storage and deletion. 
• 25465. Display of average base coverage depth results. 
• 26088. Operator role permissions. 
• 1399. Salt bridges. 
• 1425. Alert shown when not necessary. 
• 1435. Missing PCR lid failure alert. 
• 1421. Motor configuration issue on the sequencer. 
The following known issues were added. 
• 30178. Plugins that are run after a run is complete cannot be run while backup is 

in process.  
• 29229. Symantec™ antivirus software. 
• 28945. Import single runs from another Genexus™ Integrated Sequencer.  
• 29228. Edit default report template. 
• 29089. Manager role. 
• 28490. Import custom baselines. 
• 25307. Manual signature title. 
• 20701. Downloads of sequencing results from the Oncomine™ TCR Beta‑LR 

Assay GX assay. 
• 25474. Potential pool imbalance when selecting UDG option for AmpliSeq DNA 

and AmpliSeq DNA&RNA Assays. 
• 29239. Manual and automated backups.  
• 29905, 30233, and 30234 Generate and download variant reports. 
• 28908 JNPL file. 

D.0 11 February 2022 Updated with issue 23068. If you create a custom panel for the Oncomine™ BRCA 
Assay GX, exon numbering remains set by the system-installed panel for the assay. 

C.0 27 January 2022 Updated for Genexus™ Software 6.6.0.1 and 6.6.0.3. 
Updated with the following issues. 
• 23545. NTC QC results for Sample to Result runs are only visible for samples that 

are included in the purification batch with the NTC. 
• 23057. When you view the exon tile fusion imbalance charts for a sample, then 

select a different sample, the charts are not updated for the new sample that is 
selected.  

• 21541. When you view the exon tile fusion imbalance charts for a sample, then 
select a different sample, the charts are not updated for the new sample that is 
selected. 

• 17803. Run reports for runs that are started on or completed on 26–31 December 
display the incorrect year. 

• 23586. For the Oncomine™ Myeloid v2 - GX5 - DNA and Fusions - v4.2.2 assay, 
Purification QC is not included by default. 

• 17738. An “Instrument Must be Serviced” alert appears even if the instrument 
does not need to be serviced. 

B.0 3 December 2021 Updated with the following issues. 
• 22895. More than one gene annotation can be listed as Not Assayed even if one 

of the annotated genes is present in the panel. 
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• 22883. In some cases, the coverage graph is not shown for the selected gene. 
• 23074. The Oncomine Extended (5.14) filter chain launched in Genexus™ 

Software 6.2.1 was updated in Genexus™ Software 6.6. 
• 23399. The option to create a custom filter chain to filter variant results by allele 

frequency does not appear to be available. 
• 23081. An error message is shown for some DNA + RNA assays when you 

prepare a library batch with more than 24 samples. 
A.0 26 October 2021 New release notes for Ion Torrent Genexus™ Software 6.6. 

Release Notes Overview 
This document outlines features in Oncomine™ Myeloid GX v2 ADF- w4.3.2, major features in Ion Torrent™ 
Genexus™ Software 6.6, issues fixed in Genexus™ Software 6.6.2.1 and Genexus™ Software 6.6.0.3, and 
known issues to be fixed in subsequent releases. 

Oncomine™ Myeloid Assay GX v2 ADF 4.3.2 
The Oncomine™ Myeloid Assay GX v2 provides comprehensive genomic profiling of myeloid malignancies with 
analyses of SNPs and Indels in 45 genes, and an RNA fusion panel that is capable of detecting over 800 unique 
fusions. The updated Assay Definition File version 4.3.2 includes the following improvements: 

• Assay performance improvements—workflow parameters for library preparation are optimized to 
enhance amplicon uniformity and increase assay robustness and reproducibility.  

• Variant calling 
o Ion Torrent™ Variant Caller (TVC) v5.16 module was updated to v5.20. The version number is 

visible in the header of the VCF file. 
o Improved sequence variant baseline and optimized parameters to detect key variants in ASXL1, 

RUNX1, and NPM1. 
• Fusions—updated fusion reference files that enable identification of additional fusion isoforms.   
• Genexus™ Purification Instrument—buffy coat sample type was added for use when running in 

integrated mode.  

Issues fixed in Oncomine™ Myeloid Assay GX v2 ADF 4.3.2 
Issue 

number Issue Summary Impact 

23586 For the Oncomine™ Myeloid v2 - GX5 - DNA and 
Fusions - w4.2.2 assay, Purification QC was not 
included by default.  

This issue is fixed in Oncomine™ Myeloid GX 
v2 ADF- w4.3.2. 

23818 Gene symbol correction for C11orf88. This issue is fixed in Oncomine™ Myeloid GX 
v2 ADF- w4.3.2. 

 

Version information 
Release Date 15 June 2022 

Release Version 6.6.2.1 

Install Genexus™ Software 6.6.2.1 

1. In the Settings / Software Updates screen, click Software Updates in the upper right corner. 
2. In the row for the Torrent Suite package with the Available Version as 6.6.2.1, in the Actions column, 

click Download. 
After the download is complete, the Download link changes to an Install link. 

3. Click Install, then click Yes to confirm the installation. 
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Issues fixed in Genexus™ Software 6.6.2.1 patch 
Issue 

number Issue Summary Impact 

28040 A critical security vulnerability was detected in the 
following third-party libraries.  
• Spring framework versions 5.3.17 and earlier 
• Spring Boot versions 2.5.11 and earlier 
• Apache HTTP server version 2.4.52 and earlier  
Genexus™ system software uses these third-party 
libraries and used versions that were impacted with 
these vulnerabilities. 

The security vulnerability is fixed as part of the 
6.6.2.1 patch release by upgrading Spring 
Framework version to 5.3.18, Spring Boot 
version to 2.5.12 and Apache HTTP server 
version to 2.4.53 which are included in the 
software. This issue is fixed in Genexus™ 
Software 6.6.2.1.  

24649 Based on the backup settings, the sequencer backs 
up runs and saves data from the runs in the backup 
directory which was at times consuming excess 
memory and processing causing the system to 
become unresponsive. 

This issue is fixed in Genexus™ Software 
6.6.2.1.  
 

26086 Disk space was used to store sequencing raw data 
that should have been deleted in the Genexus™ 
Sequencer for runs with a status of Analysis 
Complete. 

This issue is fixed in Genexus™ Software 
6.6.2.1.  
 

25465 QC values were shown incorrectly as N/A in the QC 
tab even though the analysis generated values for 
the QC. 

This issue is fixed in Genexus™ Software 
6.6.2.1. 

26088 In Genexus™ Software 6.6, users who were 
assigned the role of Operator were not able to view 
plugin results or the pileup view in Sample Results.  

This issue is fixed in Genexus™ Software 
6.6.2.1. 
 

1399 On some instruments, after a run completes, leftover 
fluid may leak out from the chip clamp and dry, 
forming a “salt bridge” that leads to electrical noise 
during signal detection for follow on runs.  

This issue is fixed in the Genexus™ Software 
6.6.2.1. To prevent potential leaks from 
occurring after any run, the chip remains 
clamped in the sequencing position until a 
new initialization or run is started. You will be 
prompted to remove the chip before you load 
the instrument deck for a new run.  

1425 The annual maintenance alert “The instrument needs 
to be serviced” was shown on the instrument every 4 
weeks. 

This issue is fixed in the Genexus™ Software 
6.6.2.1.  

1435 The instrument software did not show an error when 
the PCR lid failed to close and the instrument 
continued the run. This issue occurred after the 
instrument was serviced and a connection was loose. 
A loose connection can cause poor thermal 
uniformity during library amplification which biases 
amplicon coverage of the sample. 

This issue is fixed in Genexus™ Software 
6.6.2.1. If the PCR lid fails to clamp an error 
message is shown that the PCR lid is not 
behaving as expected. If you see this error 
message, please contact your Field Service 
representative to schedule a repair. 
 

1421 On rare occasions the coupler shuttle on the 
instrument failed to clamp at the pipette loading 
position. The error shown on the instrument was 
“Coupler Shuttle failed to Engage-hi”. This error 
occurred because motor default configurations were 
being overwritten when the coupler shuttle was 
moved by the instrument. 

This issue is fixed in Genexus™ Software 
6.6.2.1.  
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Updates for Genexus™ Software 6.6.0.3 
Genexus™ Software 6.6.0.3 is a security patch for the vulnerability in the Apache log4j library. Apache reports 
that the security vulnerability can allow an attacker to execute code and remotely take over a system through 
the log message parameters. Genexus™ Software 6.6.0.3 is an upgrade to the log4j and logback versions to 
remove the security vulnerability. Genexus™ Software 6.6.0.3 does not include any changes to the analysis 
pipeline or system software. 

Genexus™ Software 6.6.0.3 and PQ verification 
Due to design of the software, if a performance qualification (PQ) run has been completed on a Genexus™ 
Integrated Sequencer running 6.6.0, after an update to 6.6.0.3 the PQ status changes to Not verified. Although 
the software version and the PQ status have changed , there is no impact on instrument performance. To revert 
the PQ status to Verified and document a planned deviation, contact a Field Service Engineer.  

Install Genexus™ Software 6.6.0.3 
1. In the Settings / Software Updates screen, click Software Updates in the upper right corner. 
2. In the row for the Torrent Suite package with the Available Version as 6.6.0.3, in the Actions column, 

click Download. 
After the download is complete, the Download link changes to an Install link. 

3. Click Install, then click Yes to confirm the installation. 

Version information 

Release Date 28 January 2022 

Release Version 6.6.0.3 

Log4j versions 
The security vulnerability affects log4j versions 2.0 through 2.15.0 and logback used by Genexus™ Software 
6.6. The log4j versions used by Genexus™ Software 6.6 are not listed in the EULA’s Appendix of third-party 
copyright notices and licenses. In the interim, please note as follows:  

log4j and logback packages included in Genexus™ Software 6.6 
Your continued use of Genexus™ Software 6.6 will be deemed to constitute your acceptance of the terms and 
conditions of all the third-party licenses that are listed below. 

Package Version License 

log4j 1.2.17 APACHE LICENSE, VERSION 2.0 

log4j 1.2.15 APACHE LICENSE, VERSION 2.0 

log4j 2.13.3 APACHE LICENSE, VERSION 2.0 

Logback-core 1.2.3 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1 

Logback-classic 1.2.3 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1 

log4j and logback packages included in Genexus™ Software 6.6.0.3 
Your use and installation of Genexus™ Software 6.6.0.3 will be deemed to constitute your acceptance of the 
terms and conditions of all the third-party licenses that are listed below. The log4j versions used by Genexus™ 
Software 6.6.0.3 are not listed in the EULA’s Appendix of third-party copyright notices and licenses. The log4j 
version information that is not listed in the EULA is a known issue that will be fixed in an upcoming release of 
the software.  
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Package Version License 

log4j 1.2.17 APACHE LICENSE, VERSION 2.0 

log4j 1.2.15 APACHE LICENSE, VERSION 2.0 

log4j 2.17.0 APACHE LICENSE, VERSION 2.0 

Logback-core 1.2.9 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1 

Logback-classic 1.2.9 Eclipse Public License - v 1.0, GNU Lesser General Public License 2.1 

Updates for Genexus™ Software 6.6.0.1 
Install Genexus™ Software 6.6.0.1 to have access to the latest version of the software help. The help content 
embedded in the software is not the latest version and does not completely align with the Genexus™ Software 
6.6 User Guide (Pub. No. MAN0024953). Genexus™ Software 6.6.0.1 does not include any changes to the 
analysis pipeline or system software. 

Install Genexus™ Software 6.6.0.1 
1. In the Settings / Software Updates screen, click Software Updates in the upper right corner. 
2. In the row for the Torrent Suite package, with the Available Version of 6.6.0.3, in the Actions column, 

click Download. 
After the download is complete, the Download link changes to an Install link. 

3. Click Install, then click Yes to confirm the installation. 
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GX 6.6 Key Enhancements 
Support integration of the Ion Torrent™ Genexus™ Purification Instrument 
The Ion Torrent™ Genexus™ System is the first turnkey next-generation sequencing (NGS) solution that 
automates the sample-to-report workflow and delivers results in a single day. Genexus™ Software 6.6 can be 
used to plan the Sample to Result run with the integrated Genexus™ Purification Instrument and Genexus™ 
Integrated Sequencer. The software tracks samples from purification through sequencing to post-run sample 
reports.  

Performance improvements 
Genexus™ Software 6.6 provides a faster import of files. 

Dashboard 
The dashboard is the home screen for the software. In the software dashboard, you can view details, such as 
the QC status, for the five most recent runs, the status of the instruments that are integrated with the software, 
and instrument alarms, if any. 

Enhancements to custom variant reports 
With custom variant report enhancements, you can now perform the following functions. 

• Create custom report templates. In the template, you can customize sample details, variant sections, 
custom text, images, electronic signatures, and manual signature sections. 

• Add descriptions, titles, and footnotes to each section of the template. 
• Add custom text and images to the template that you can edit when you generate the report.  
• Associate up to 3 default templates for an application category. When default templates are associated 

with an application category, a variant report is generated at the end of the run.  
• Select the report language. 
• Include images shown in the results screens in reports. 

Positive control  
You can include a positive control for Sample to Result runs. 

Multiple electronic signatures for variant reports 
Multiple users can electronically sign variant reports. The electronic signatures appear in the PDF report. In 
addition, multiple signature levels can be enabled in the software. One signature level can be designated to lock 
the report to prevent further changes. The first user who signs the report can modify the report template 
selection and modify the report. Subsequent users can only sign the report and add comments. Reports can be 
amended until 30 days after a run is complete. 
You can also now send notifications to other users in Genexus™ Software. For example, you can notify another 
user when you have signed a variant report. 

Enhancements to Results screens 
• The Key Variants matrix provides a color-coded visual representation of the variant results. Each tile in 

the Key Variants matrix represents one variant and indicates whether a variant is detected or not.  
• Amplicon coverage graphs provide a high-level overview of coverage to help you determine whether 

the sequencing reads across a gene are uniform and sufficient. 
• Variant tracks are shown with the pileup view in Genexus™ Software. The pileup is a figure generated 

in the software that shows each BAM track represented by a single bar, with the sequence variation or 
variations denoted in each track. The BAM tracks are aligned against a reference track. The variant 
pileup can be used to identify potential variants. 

• The variant results shown in the Key Findings are organized into the following categories: Key Variants 
Detected, Other Variants Detected, None Detected, and Not Assayed.  

Enhancements to data backup 
You can now automatically back up older run data, results files, and signed reports to local or cloud storage and 
set a schedule to automatically delete backed up runs after a specified amount of time. 
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Enable LIMS sample attribute and vocabulary mapping 
You can now map the names of sample attributes that are used by external LIMS software to the names of the 
sample attributes recognized by Genexus™ Software 6.6. The mapped sample attributes are associated with 
one or more application categories. LIMS attribute mapping allows you to seamlessly import a file, in XLS, CSV, 
or TSV format, that you have exported from external LIMS software to add samples in the software. 

You can also now map alternate vocabulary values for sample attributes that are not recognized in the software.  

Variant classifications are shown in VCF files  
Custom classifications, such as benign or likely pathogenic, that you create and assign to variants, are now 
included in VCF files that you can download.  

New TNA custom assay creation 
You can now create custom assays for total nucleic acid (TNA) to detect and annotate DNA and fusion variants 
from cell free nucleic acid. 

Improvements to sample management 
You can now copy and edit multiple samples at once. You can also add sample tags to one or more samples or 
sample results. Sample tags can be used to group and track samples in the software. The tags that you create 
can be nested. You can easily find samples when you search or filter the samples or sample results according 
to a sample tag. Sample tags are also supported in the LIMS API.  

Encryption of sample information  
Sample information is now stored in an encrypted format in the software for increased security. 

Updates to edit a sample after a run is complete 
In Genexus™ Software 6.6, after a run is complete, a manager- or administrator-level user can edit a sample for 
30 days. You must reanalyze the sample to generate results and a new variant report for the sample. 

Improvements to sign in 
You must now select and answer security questions the first time you sign in. The security questions are used to 
validate identity when the password is reset.  

Enable custom RNA Exon Tile assay baselines and sequencing variants baselines 
You can now generate panel specific custom RNA Exon Tile assay baselines and sequencing variant baselines. 
You can also export, import, and obsolete the custom baselines. 

Enable import from AmpliSeq.com 
Manager- and administrator-level users can now directly import custom or fixed panel files into Genexus™ 
Software from Ion AmpliSeq™ Designer. 

Enable reanalysis  
If a sequencing run fails to meet one or more QC parameters defined by the assay, you can adjust the assay 
parameters and reanalyze a sample or a run. Reanalysis of runs per assay can start from the alignment, 
basecalling, or signal processing steps. A sample can be reanalyzed starting only from the alignment step. For 
both runs and samples, the files needed for the stage of reanalysis that you select must be present in the 
software. 

GRCh38 Support 
Genexus™ Software 6.6 now includes the GRCh38 reference genome file as a preset to use in assays. 

User experience improvements 
• You can now search, filter, and sort the information that is shown in the software screens from each 

column header in the tables. This allows you to search and filter the information with multiple filter 

https://www.ampliseq.com/login/login.action
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options enabled sequentially. This applies to the information shown in the samples, assays, run plans, 
and results screens. 

• Actions that are available for an item in a table, such as copy or edit a sample in the Manage Samples 
screen, are now shown when you place the pointer over a row. 

• System notifications are now shown with an alert and notifications button in the menu bar. 

New BAM to Result workflow 
You can now create samples from BAM files, then plan BAM to Result runs to analyze the BAM samples. 

Extraction and control kit barcodes 
You can track samples with the extraction kit barcode associated with the sample when you plan a Nucleic Acid 
to Result run. In addition, you can track control kits with the control kit barcode when you plan a Nucleic Acid to 
Result run. The barcodes are shown in the software screens and in the variant report PDF file. 

Enable support of Genexus to Genexus sample and BAM file transfer 
You can now upload BAM files to another Genexus™ Software server and enable analysis in the target server 
to start immediately after the files are transferred. You can enable the file transfer when you plan a run or you 
can upload result files after a run is complete. 
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Update Genexus™ Software to 6.6  
Format a USB drive for a software update 
Pre-requisites: 

• An Ubuntu Linux desktop machine with disk utility software. 
• A USB drive with a capacity of 60 GB or more. 

 
1. Insert the USB drive into the Ubuntu Linux machine. 
2. With Ubuntu running, open the disk utility by navigating to System Administration►Disk Utility. 
3. Select the USB Flash Drive (SMI USB DISK) under Peripheral Devices from Storage Devices by 

clicking on it. Highlight the volumes (New Volume FAT >60 GB), click Unmount Volume, then click 
Delete Partition. Click Delete to confirm. 

4. Select the free USB volume, then click Create Partition. 
5. Deselect the Take ownership of file system check box. 
6. Select ext3 from the Type dropdown menu, then select the entire size of the partition. Name the 

partition usbinstall. 
Note: The partition name must be completely lowercase. 

7. Click Mount. 
8. The mount point of the USB drive is /media/usbinstall. 

Download and install software with a USB drive (administrator) 
Pre-requisites: 

• Format a USB drive for the software update. See Format a USB drive for a software update. 
• Access or create a Thermo Fisher Connect account.  

1. Sign in to the Thermo Fisher App Store on Connect at apps.thermofisher.com. 
2. On the left side of the App Store screen, click the AppConnect button. 
3. On the right side of the screen, under Resource Libraries, click Ion Torrent™ Genexus™. 
4. Click Software Update. 
5. In the Ion Torrent™ Genexus™ Software table, in the row for version 6.6, click the Download button. 
6. Copy the downloaded package (.zip) to the /media/usbinstall folder in the USB drive. 
7. After completion, unmount the USB drive, then insert the drive into one of the USB ports at the back of 

the Genexus™ Integrated Sequencer. 
8. In the menu bar of the Genexus™ Software, click (Settings) ►Software Updates, then click Software 

Updates in the upper right corner. 
9. Select USB. 
10. Click Install. When the confirmation window appears, click Yes to confirm that you want to install the 

update. 
11. Click Installed Software to verify the installation when installation is complete. 

  

https://apps.thermofisher.com/
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Issues fixed in Genexus™ Software 6.6  
Issue 
number  

Description  

11298 The session time-out on the Genexus™ Integrated Sequencer touchscreen does not work after 
you abort a run or after the post-run clean stage. This issue is fixed in Genexus™ Software 6.6. 

11310 Analysis for any assay that uses a non-hg19 reference genome fails. This issue is fixed in 
Genexus™ Software 6.6. 

12378 Sporadic failure while importing an assay. This issue is fixed in Genexus™ Software 6.6. 

13190 For some assays, when you create a library batch that does not include a no template control 
(NTC), then edit the library batch to include a NTC, unique barcodes are not assigned. This issue 
is fixed in Genexus™ Software 6.6. 

13192 The Download files menu fails to open intermittently. This issue is fixed in Genexus™ Software 
6.6. 

13199 An incorrect start time is displayed for reanalyzed runs and assays. This issue is fixed in 
Genexus™ Software 6.6. 

13213 An incorrect message displayed when a new user is prompted to change the password. This issue 
is fixed in Genexus™ Software 6.6. 

13223 The Forgot password user link in the sign in screen forces you to set a new password twice. This 
issue is fixed in Genexus™ Software 6.6. 

13233 Users may experience a frozen popup window when adding a new user from Settings►User 
Management. This issue is fixed in Genexus™ Software 6.6. 

13234 For a multi-assay run, when the Customer Support Archive (CSA) plugin finishes execution for 
one of the assays, the status of the CSA plugin for the other assays also erroneously gets 
updated to a status of Completed. This issue is fixed in Genexus™ Software 6.6. 

13238 The minimum cellularity threshold for a given assay should prevent only samples with a cellularity 
lower than the threshold from being added to a run plan. However, samples with passing criteria 
are also not added to a run plan. This issue is fixed in Genexus™ Software 6.6. 

13362 For an imported assay, the chip type value is NA in the audit record. This issue is fixed in 
Genexus™ Software 6.6. 

13593 Spearman's correlation coefficient is calculated incorrectly when performing a pairwise sample 
comparison in the Oncomine™ TCR Beta-LR GX assay. This issue is fixed in Genexus™ 
Software 6.6. 

15753 When you copy the Oncomine™ Myeloid Assay GX (using the Manage Assays►Copy workflow) 
to modify system-installed assay settings, the PCR denature temperature parameter from the 
system-installed assay is not passed to the copied assay. This issue is fixed in Genexus™ 
Software 6.6. 
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Known issues in Genexus™ Software 6.6 and 6.6.2.1 
Issue 
number  Issue Summary Impact and Mitigation1 

30178 If you click Run Plugin for a sample 
result while data backup is in progress, 
the 1.wells files, the basecaller output, 
and the coverageAnalysis plugin source 
files for the sample result are deleted. If 
this issue occurs, the Loading Density 
image and histograms are not shown in 
the Assay Metrics and Run Report 
screens and values are absent for some 
QC metrics. Note: The affected run 
report data are available in the Run 
Report PDF. 

This issue occurs if you click Run Plugin to re-run any 
plugin while data backup is in progress. After this issue 
occurs, all later runs are affected. Affected results 
include coverageAnalysis and 
molecularCoverageAnalysis plugin results and QC 
metrics. 
Mitigation: Do not run re-run any plugin after a run is 
complete while data backup is in progress or if there is 
another analysis in process. Contact an FBS or FSE if 
you observe that the Loading Density image and 
histograms are not shown in the Run Report screen or 
values are absent for some QC metrics. 

29229 Updated definition files in Symantec™ 
antivirus software block the analysis 
process in Genexus™ Software . 

This recent issue occurs if you have updated the 
Symantec™ definition files. Antivirus software definition 
files are updated frequently, sometimes daily. Definition 
file updates for antivirus software can bring additional 
settings or updates to the system which can affect 
Genexus™ Software. 
Mitigation: 
Do not use Symantec™ antivirus software with 
Genexus™ Software. We have tested Genexus™ 
Software with the following antivirus software products 
and found them compatible as antivirus solutions:  
• Bitdefender GravityZone™ Business Security with 

definition files updated on 6 May 2022.  
• Kaspersky™ Endpoint Security for Linux with 

definition files updated on 5 May 2022.  
• ESET NOD32 with definition files updated on 

12 May 2022. 
28945 If sequencing run results are imported 

to another Genexus™ Integrated 
Sequencer, a signed report that is 
locked for electronic signatures is 
shown as a draft report on the system 
with the imported results. The draft PDF 
report shows the electronic signature 
details for the sign-off.  

Only runs with signed reports that are imported from 
one system to another are affected.  
Mitigation: You can optionally sign off the report after 
the report is imported or view the existing report with 
the sign off information. 

29228 If there are three report templates 
marked as Default for an assay or 
application category, you cannot edit 
the report template. 

This issue occurs only when there are three default 
report templates for the assay or application category. 
Mitigation: Remove the Default selection during 
editing, then set the report template back to default. 
Click Assays►Manage Presets►Report Templates, 
then in the row of the report template, click Undo 
Default or Set as Default. 

29089 Users assigned to accounts with the 
Manager Role are unable to access 
Audit records for the Services screen 
and Sample Attribute mapping. 

This issue affects only users accounts that are 
assigned Manager Role permissions.  
Mitigation: Sign in as an Administrator-user to view all 
audit records. 
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28490 Custom baselines (CNV baselines, 
sequence variant baselines, exon tile 
assay baseline) created on one 
Genexus™ system cannot be imported 
to another Genexus™ system in ZIP 
format. 

This issue affects the import of custom baselines from 
one Genexus™ system to another Genexus™ system. 
Mitigation: 
• Create CNV and sequence variant baselines, then 

import the baseline files in H5 (CNV) or BED (SVB) 
format. 

• Import exon tile assay baselines in TXT format. 
25307 The manual signature title of a report is 

not displayed correctly when the default 
report template is used. 

This issue affects only the manual signature titles when 
a default report template is used. 
Mitigation: For reports with a manual signature, use a 
report template that is not set as default to view the 
correct title for the manual signature in the report. 

20701 Downloads of sequencing results from 
the Oncomine™ TCR Beta‑LR Assay 
GX assay that include unmapped BAM 
and FASTQ files do not show a dialog 
box that shows the download has 
started and is successful. 

This issue affects only files available to download for 
results from the Oncomine™ TCR Beta‑LR Assay GX 
assay. 
Mitigation: When you download the files, do not exit 
from the software. Files are available after 
approximately five minutes. 

25474 The Uracil DNA Glycosylase (UDG) 
Treat DNA setting is used to clean up 
deaminated Cytosine bases from 
degraded samples. If you enable the 
UDG Treat DNA parameter in an assay, 
you may observe read imbalance in the 
Barcodes with Reads Reported table. 
Read imbalance can occur because the 
on-instrument dilution of input sample 
nucleic acid is impacted by this setting. 

This issue affects assays for DNA or DNA and Fusions 
if you enable the UDG Treat DNA parameter in the 
Library Prep & Templating section of the Parameters 
step in assay creation or when you copy, then edit an 
assay. The issue can result in over dilution of nucleic 
acid prior to library prep for AmpliSeq, and over dilution 
of the second pool in AmpliSeq and AmpliSeq HD two 
pool assays, leading to pool imbalance in the final 
reads. 
Mitigation:  
If possible, do not enable the UDG Treat DNA 
parameter for AmpliSeq HD assays with two or more 
pools and for AmpliSeq assays. Manually dilute the 
DNA sample if UDG treatment is necessary. Contact 
an FAS for help.  

29239 If manual and automated backups occur 
at the same time, the intermediate files 
may be deleted without a successful 
backup. 

When you use the Backup and Restore option, do not 
use the Start Now backup option if you want to back up 
intermediate files. 

29905 If you enable Generate Report when 
you plan a run, you cannot download 
variant reports when you click …(More 
Options)Download Files  and select 
the Reports checkbox in the Download 
Files dialog box. 

This issue affects only variant reports that are selected 
for download as part of the Reports list in the 
Download Files dialog box. 
Mitigation: Click Lab Reports in the Download Files 
dialog box to download variant reports. 

30233 If you enable Generate Report when 
you plan a run, the report that is 
generated is always in English 
regardless of the language that is 
associated with the report template. 

This issue affects report templates for non-English 
languages that are selected for generation when you 
plan a run. 
Mitigation: To create reports in languages other than 
English, do not enable the Generate Report option 
when you plan a run. Instead, use the Reports tab to 
generate reports after the run is complete. 
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30234 If you enable Generate Report when 
you plan a run, the language is not 
shown in the pane for the report in the 
Reports tab. 

This issue affects only the language information that is 
shown. The report is generated in English. 

28908 For some results, the ClinVar track is 
not shown in the Integrative Genomics 
Viewer (IGV) view that is generated with 
the JNLP files that are downloaded from 
Genexus™ Software.  

This is an intermittent issue that affects only some 
results with ClinVar annotations. 
Mitigation: Use the pileup view in Genexus™ 
Software. 
 

21372 The software update from version 6.2 to 
6.6 fails when you try to install the 
software directly from the App Store. 

This issue occurs for all software updates to version 
6.6 from the App Store. 
Mitigation: Download and install Genexus™ Software 
6.6 with a USB drive. For more information, see 
Update Genexus™ Software to 6.6. 

 20875 
 

For samples with a disease category of 
cancer that were created in Genexus™ 
Software 6.2, you cannot plan a run or 
generate a report unless you first edit 
the application category of the samples.  

This issue affects samples created in Genexus™ 
Software 6.2. Disease category was a sample attribute 
in version 6.2, but in version 6.6, the correlated 
attribute is application category. (Cancer is not an 
available option in version 6.6.) 
Mitigation: For samples with a disease category of 
cancer created in Genexus™ Software 6.2, edit the 
application category before you plan a run or generate 
a report with the samples in Genexus™ Software 6.6. 
Alternatively, you can copy samples that you created in 
version 6.2, edit the application category for version 
6.6, then plan a run with the new samples. 

 20720 
 

If you have added all available columns 
to the list of samples in the Samples / 
Manage Samples screen and then try 
to filter the list of samples with the Tags 
column, an error message is shown.  

This rare issue occurs only when you select all 
available columns in the Columns dropdown list and 
do not save the column preferences, then use the filter 
tool in the Tags column. 
Mitigation: Before you use the Tags column to filter 
the list of samples, save any new column preferences 
or ensure that at least one available column is 
unselected. 

 21585 
  

When you edit multiple samples at once 
and change the cellularity or necrosis 
value for one sample, the new value is 
applied to all samples in the Edit 
Sample screen. 
 

This issue occurs only when you change the cellularity 
or necrosis value of a sample when you have selected 
multiple samples to edit together. 
Mitigation: Only change the cellularity or necrosis of a 
single sample at a time.  
1. In the Manage Samples screen, place the pointer 

over the row of a sample that you want to edit, click 
Edit. 

2. Change the cellularity or necrosis value of the 
single sample. 

 21293 
 

If you create a custom sample attribute 
with an attribute name that contains a 
full stop or period (.), the entries for that 
sample attribute are not shown in the 
Manage Samples table. 

This issue affects only custom sample attributes with a 
period in the name of the attribute. 
Mitigation: 
• View the entry for a custom sample attribute for a 

single sample. (Click Samples►Manage 
Samples, then click a sample name.)  

• When you create a custom sample attribute, do not 
include a period in the name of the attribute. 
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 20696 
 

In any column header, when you click 
Filter, enter any information in the 
search field, then click Enter, all options 
that are listed in the filter dialog box are 
selected. 

This issue applies to all searches in the filter dialog 
boxes in all screens. 
Mitigation: In the filter dialog boxes, do not click Enter 
except to select all options. 

16405 
 

If you have completed a run with 
Genexus™ Software 6.2, then upgrade 
to Genexus™ Software 6.6, the run 
report is not available to download. 

This issue affects results generated in version 6.2, then 
viewed in the version 6.6 software. 
Mitigation: Although you cannot download a PDF file 
of the run report, you can view the information that is 
shown in the run report when you view the Assay 
Metrics for each assay in the run.  

21487 BAM to Result runs are not compatible 
with assays that are created or installed 
in previous versions of the software. 

This issue affects all system-installed or custom assays 
from Genexus™ Software 6.2.1 or earlier.  

21985 
 

If you perform a run with a sample, then 
perform a second run with the same 
sample, you cannot edit the sample 
information if needed after the second 
run. 

This issue affects all samples that are included in at 
least two completed run plans. 
Mitigation: Ensure that all sample information is 
correct before you assign a sample to a second run 
plan. To preserve the option to edit a sample for 30 
days after a run is complete, copy a sample that has 
been included in a completed run, then assign the new, 
copied sample to a run plan. 

 20742 
 

If you enable the option to upload 
immune repertoire BAM files to another 
Genexus™ Software server when you 
plan a run, the option to perform an 
analysis in the target software 
automatically after run completion is not 
available.  

This issue affects only immune repertoire assays when 
you plan a run.  
Mitigation: After the sample data is transferred to the 
target server, plan a BAM to Result run with the 
transferred samples. 

 23545 NTC QC results for Sample to Result 
runs are only visible for samples that 
are included in the purification batch 
with the NTC. 

This issue affects Sample to Result runs for some 
system-installed or custom assays that include more 
than one purification batch. 
Mitigation: In the Run Summary, in the Batch ID 
column, view the purification batch of samples and the 
NTC. To view NTC QC results, view the QC tab for a 
sample that was included in the purification batch with 
the NTC.  

 21485 
 

If you try to compare immune repertoire 
results from BAM samples that have 
been uploaded from another 
Genexus™ Software server, no 
comparison results are shown. 

This issue affects only the comparison of immune 
repertoire results from BAM samples that have been 
uploaded from another Genexus™ Software server.  

12692 Missing variant label and legend chart 
customization options for charts 
generated when you compare samples. 

This is a chart customization issue that does not affect 
sequencing results.  

22549 In the Key Findings tab, in the 
Coverage Graph for genes that are 
transcribed from the reverse strand, the 
order of the exons is shown incorrectly 
when you place the pointer over the 
transcript track. Exons are always 
numbered left to right, ignoring 
directionality of the gene. 

This issue affects all genes transcribed from the 
reverse strand.  
Mitigation: Ignore the exon numbers that are shown in 
the transcript track. 
For instructions to view the transcript and get the 
correct exon numbers for coverage metrics, see View 
the correct orientation of transcripts that are 
transcribed from the reverse strand. 
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22895 In the Key Findings tab, in the Key 
Variants matrix, variants with more 
than one gene annotation can be listed 
as Not Assayed even if one of the 
annotated genes is present in the panel. 
Affected variants are shown in the Key 
Variants matrix only when the Not 
Assayed checkbox is selected and 
appear at the end of the matrix in a 
white tile instead of a blue tile.  
Example: 

 

This issue can affect variants with more than one gene 
annotation; for example, U2AF1L5/U2AF1. 
Identify if a variant is affected by this issue. 
1. For any gene tile that is shown only when the Not 

Assayed checkbox is selected, click the Variant ID 
to open the Variants tab. 

2. Scroll up to view the variant in the Variants table. 
3. In Variants table, in the Gene column, if the 

variant is listed with ** to indicate that more than 
one gene is detected, click the Annotations tab.  

4. Scroll to the Gene row to view the multiple 
annotations for the gene. 

Mitigation: When you view the Key Variants matrix, 
ensure that you select the Not Assayed checkbox, if 
available, to review variants that are not assayed.  

22883 If you select a gene that is not shown by 
default in the Coverage Graphs, in 
some cases, the coverage graph is not 
shown for the gene that you select.  

This issue affects some genes that are not shown by 
default in the Coverage Graph. Even if the graph is 
labeled correctly with the selected gene, the coverage 
information is not updated correctly. 
Mitigation: Ignore the Coverage Graph that appears 
when you first select a gene from the Show Coverage 
for Gene dropdown list. Refresh the browser window to 
view the correct Coverage Graph for the gene. 

23074 The Oncomine Extended (5.14) filter 
chain launched in Genexus™ Software 
6.2.1 was updated in Genexus™ 
Software 6.6. The improvements, which 
are part of Oncomine Extended (5.16) 
filter chain, are also included in the 
Oncomine Extended (5.14) filter chain 
in Genexus™ Software 6.6. This update 
can result in rare differences to Filtered 
Variants in Genexus™ Software 6.6 
when compared to results viewed with 
the Oncomine Extended (5.14) filter 
chain in Genexus™ Software 6.2.1.  

This rare issue affects results that are viewed when the 
Oncomine Extended (5.14) filter chain is applied and 
compared to results in Genexus™ Software 6.2.1. This 
rare issue could affect the following Filtered Variants. 
• Likely somatic de novo splice variants that are not 

hotspot splice variants or ClinVar pathogenic 
variants are filtered in. (Hotspot splice site variants 
and ClinVar pathogenic variants are not affected by 
this issue.) 

 21778 
 

For some assays, when you view all of 
the variants in the Variants table, you 
can add the P-Value column to the 
table twice. 

This issue occurs only for some assays when you view 
all variants in the Variants table. The data in the 
duplicated columns are the same. 
Mitigation: You can ignore or remove the duplicated 
P-Value column in the Variants table with the 
Columns dropdown list. Alternatively, you can view the 
SNVs/Indels or CNVs tables. A single P-Value column 
is available in the SNVs/Indels and CNVs tables.  

 23399 The option to create a custom filter 
chain to filter variant results by allele 
frequency does not appear to be 
available (Assays►Manage 
Presets►Filter Chains►Add 
New►Choose Filter). 

This issue affects custom filter chains created to filter 
variant results by allele frequency.  
Mitigation: Select the Allele Fraction filter to create a 
custom filter chain to filter variant results by Allele 
Frequency. 
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 21930 If you create a custom filter chain for a 
variant classification, then try to apply 
the custom filter chain to a result, a 
“Data not available” message appears. 

This issue affects all custom filter chains that include a 
Variant Classification filter. 
Mitigation: Find and filter user classifications in the 
following ways. 
• In the Variants tables, in the User Classification 

column header, use the filter and search tool to 
limit the variant classifications that are shown.  

• Download the Filtered Variants VCF file to view 
and search for variant classifications. 

17425 
 

In rare instances, the order of the reads 
shown in the BAM track is not 
consistent each time you view the BAM 
track in the Gene Browser. 
 
 

 

 
 

This issue occurs only when the total read count 
exceeds the maximum read count threshold that is set 
for optimal browser performance. When the threshold 
is exceeded, the Gene Browser shows a specified 
number of randomly sampled alignments configured by 
downsampling parameters. The coverage track is not 
affected by this issue. 
Mitigation: You can adjust the downsample reads 
parameter and view the full BAM track with the Broad 
Institute Integrative Genomics Viewer (IGV). For more 
information, see “View variants with IGV” in the 
software help system. 

21794 
 

In the Gene Browser, in some 
instances, the target region is 
represented with a black color instead 
of green. 

This issue occurs only for some variants. There is no 
impact to the data, except for the color change in the 
image. 

13478 When you click any of the links for the 
Exome Aggregation Consortium (ExAC) 
browser in the Annotations tab shown 
below the Variants table, the following 
message is shown: “The ExAC browser 
is no longer available. ExAC data is 
available in the gnomAD browser or can 
be downloaded from gs://gnomad-
public/legacy. 
View this page in the gnomAD browser. 
You will be automatically redirected in 
24 seconds. “ 

This issue occurs when you click any of the links for the 
ExAC browser. 
Mitigation: Click the updated gnomAD browser link or 
wait to be redirected. 
 

23068 If you create a custom panel for the 
Oncomine™ BRCA Assay GX, exon 
numbering remains set by the system-
installed panel for the assay. As a 
result, when you use a custom panel 
that is based on a reference sequence 
version that is different from the system-
installed panel, exon numbering for 
BRCA1 is not correct when you 
visualize exon and whole gene CNVs.  

This rare issue affects the visualization of BRCA1 for 
the Oncomine™ BRCA Assay GX if you use a custom 
panel with a version of the reference sequence that is 
different from the system-installed panel for the assay. 
The system-installed version of the reference sequence 
is NM_007294.4. 
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23057 When you view the exon tile fusion 
imbalance charts for a sample, then 
select a different sample, the charts are 
not updated for the new sample that is 
selected.  

This issue affects the charts that are shown for the 
RNA exon tile fusion imbalance results for the 
Oncomine™ Precision Assay GX. 
Mitigation:  
1. Leave the Results section. For example, click 

Dashboard. 
2. Click Results►Sample Results, then click the 

sample name for the RNA exon tile fusion 
imbalance charts that you want to view. 

3. Click the Variants tab, then click Fusions. 
4. Click Visualization►RNA Exon Tile Fusion 

Imbalance. 
21541 If you import a custom exon tile assay 

baseline file in an unsupported file 
format, you are not notified that the 
import failed. The unsupported file 
appears in the Exon Tile Assay 
baselines list after import. However, 
analysis fails if the custom assay 
baseline is used in a run plan. 

This issue occurs only if you attempt to import a 
custom exon tile assay baseline file in an unsupported 
file format. 
Mitigation: Ensure that custom exon tile assay 
baselines that you import are in a supported file format. 

21320 
 

If the name of a variant report template 
includes a special character of @,*,#, or 
$, you cannot view or download variant 
reports generated with the template. 

This issue affects any variant report with @,*,#, or $ in 
the name of the variant report template. 
Mitigation: Create a new variant report template 
without @,*,#, or $ in the name, then generate a new 
report. 

17803 The dates for runs that are started on or 
completed on  
26–31 December display the incorrect 
year. The date that is shown is one year 
later than the actual date. For example, 
for a run started and completed on  
2021-12-30, the started on and 
completed on date is incorrectly shown 
as 2022-12-30. 

This issue affects all runs that are started on or 
completed on 26–31 December. The incorrect date is 
shown in the Variant Report PDF (if Sequencing Run 
Details are included in the report template), in the Run 
Report PDF, in the Sample Summary file (the info.csv 
file), in the Run Report tab, and in the Run Summary 
tab. 

. 21508 
 

If you have installed Ion Torrent™ 
Oncomine™ Reporter software and you 
generate an Oncomine™ Reporter 
Report in text format, the following error 
message is displayed: “Failed to load 
PDF document.” 

This issue affects only Oncomine™ Reporter Reports 
in text format. 
Mitigation: To view an Oncomine™ Reporter Reports 
in text format, download the report, then view the report 
in a compatible text file viewer. 

23081 When you try to prepare a library batch 
with more than 24 samples, an error 
message is shown for some DNA + 
RNA assays. 

This issue affects some system installed and custom 
DNA + RNA assays when you select more than 24 
samples during library batch preparation.  
Mitigation: Create an XLS or XLSX file that contains 
the library batch information from a template file 
provided in the Import Library Batch screen, then 
import the library batch file. 

. 20579 
 

For runs that use an assay that has 
been enabled for resequencing, the log 
files for the resequencing portion of the 
run are located in a separate folder 
called “Reseq”. 

This issue affects all runs that include resequencing.  



Genexus™ Software 6.6 Release Notes 19 

Issue 
number  Issue Summary Impact and Mitigation1 

22005 
 

When you try to download a BAM result 
file that is larger than 2 GB, the file that 
is downloaded is 0 KB and does not 
contain any data. 
 

This issue affects all BAM files larger than 2 GB that 
you attempt to download in the software or from the 
web services API. 
Mitigation: For help with the following procedure, 
contact a Field Bioinformatics Specialist (FBS). 
Pre-requisite: Administrator-level user with a configured 
Secure Shell (SSH) key 
1. Use a command-line interface to view the BAM 

results files in the folder 
/results/analysis/output/reports/.  

2. In the folder of files that is returned, search by 
sample name to find the BAM file of interest.  
Contact an FBS for help if the result was 
reanalyzed and multiple subfolders are listed.   

3. Copy BAM files from the server to the computer 
with SSH. 

The file location on the server is: 
/results/analysis/output/reports/[Sample specific 
LIMS folder]. 

20738 Downloading multiple Customer 
Support Archive (CSA) files 
simultaneously fails. 

This issue occurs when you try to download a CSA file 
while another CSA file is downloading. This issue 
occurs in the Run Results, Sample Results, and 
Verification Results screens. 
Mitigation: You must wait for a CSA file to download 
successfully before you can download another CSA 
file. 

16765 
 

Results generated by the 
coverageAnalysis plugin for RNA 
samples with an application category of 
oncology are not informative.  

This issue occurs only when you view the 
coverageAnalysis plugin results in the Plugins tab for 
an oncology RNA sample. 
Mitigation: For oncology RNA samples, you can ignore 
the coverageAnalysis plugin results shown in the 
Plugins tab. 

. 21486 
 

If you upload a DNA & RNA sample 
result from one Genexus™ Software 
server to another and the name of the 
sample is more than 50 characters long, 
two samples are created on the target 
server. One sample is for DNA (with a 
sample type of DNA & RNA) and 
another is for RNA (with a sample type 
of RNA). 

This issue affects only samples that have a name that 
is more than 50 characters long. 
Mitigation:  
• When you create a sample, limit the name to less 

than 50 characters. 
• For each sample that you want to upload to anther 

Genexus™ Software server, edit the sample name 
so that the name is less than 50 characters.  

• If two samples are created on the target server, 
select both samples when you plan a BAM to 
Result run. 

16763 If you import run results 
from another Genexus™ Software 
server that has a different version of a 
plugin used in the run; you cannot see 
the plugin results in the Plugins tab 
when you view the results on the target 
server. 

This issue affects results that are imported in a 
Genexus™ Software server that has a different version 
than the source Genexus™ Software server. 
Mitigation: Run the plugins again in the target server 
(from a sample result, click the More Options 
button►Run Plugin). 
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21357 In the Manage Assays screen, when 
you select DNA and Fusions, DNA, 
Fusions to refine the assay list with the 
filter tool in the Research Application 
header, no records are shown even if 
records are available. 

This issue affects only the filter selection of DNA and 
Fusions, DNA, Fusions in the Research Application 
column. 
Mitigation: First enter the term DNA and Fusions, 
DNA, Fusions in the search field, then select the DNA 
and Fusions, DNA, Fusions checkbox to refine the 
list. 

21807 When you create some custom assays 
or copy and edit some assays, you can 
enable, edit, and view Microsatellite 
Instability (MSI) parameters in the 
Parameters step of assay creation 
even though the MSI parameters are 
not applied in the analysis. 

This issue affects some custom assays. 
Mitigation: Ignore MSI parameter settings in custom 
assays when results do not show MSI metrics. 

 21712 
 

When you try to sort by name the list of 
copy number baselines, sequence 
variant baselines, or exon tile assay 
baselines, the following error message 
appears: “We are unable to complete 
the requested action due to a system 
error.” 
 

This issue occurs only when you try to sort the list of 
copy number baselines, sequence variant baselines, or 
exon tile assay baselines by name. 
Mitigation: You can sort the lists of baselines when 
you click any other column header. You can also scroll 
to the bottom of the screen, and if applicable, view 
other pages of each baseline, to view the baselines at 
the end of the list. 

. 21086 
 

When you click Settings►Backup & 
Restore►Start Now, system backup 
starts immediately without a 
confirmation dialog box. 

This issue occurs when you start an unscheduled 
system backup.  
Mitigation: Ensure that you intend to start a system 
backup before you click Settings►Backup & 
Restore►Start Now. 

794 If a USB update for the purification 
instrument fails, you are not notified.  

When you attempt to update the purification instrument 
software from a USB, the message “Install Completed; 
Please Reboot Now” appears regardless of whether 
the software update is successful. 
Tap Instrument Settings►About to view the software 
version and confirm that the software update is 
complete. 

13222 Deck loading instructions jump between 
sections before completion of each 
section. 

This issue can result in a suboptimal user experience 
while the deck is set up. It does not, however, cause 
any misplacement of deck consumables.  

1316 
 

If the error message “Lane clog check 
failed” is shown after a clean instrument 
procedure, the message appears only 
briefly. 
 
 

This is a rare issue that only occurs if the sequencing 
instrument detects a lane clog after performing a clean 
instrument procedure. If a lane clog occurs and you do 
not see the error message, you are notified to perform 
a clean instrument procedure when you start a run. 
Mitigation: Contact Technical Support 
for help to fix a clog. 

1Mitigation is included if applicable.  
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View the correct orientation of transcripts that are transcribed 
from the reverse strand 
You can view the direction of transcripts and get correct exon numbers with the Broad Institute Integrative 
Genomics Viewer (IGV) or with other genome browsers, such as the UCSC Human Genome Browser. 

Enable IGV 
Pre-requisite: 

• Java™ Web Start version 8 (64-bit) installed. If you are running Java™ 9 or later, you must also have 
Java™ 8 for the JNLP to work correctly to view variants in IGV. 

1. Run Configure Java. 

2. In the Java Control Panel, in the Security tab, click Edit Site List. 

3. In the Exception Site List, click Add, enter the Genexus™ Software URL, for example, https://<your 
server address>, then click OK. 

4. Click OK to close the Control Panel. 

View a coverage graph in IGV 
1. In Genexus™ Software, click the Variants tab. 
2. In the row of the variant of interest, in the Locus column, copy the locus for the variant. 
3. In the Variant ID column, click the link for the variant of interest. 
4. In the Gene Browser that opens below the variants table, click View in IGV. 
5. In the warning message that appears at the bottom of the screen, click Keep. 
6. At the bottom of the screen, click the name of the file. 
7. In the warning message dialog box that appears, click Continue. 
8. In the Security Warning dialog box that appears, accept the risk, then click Run. 

The transcript is shown in IGV in a new window. 
9. In IGV, in the search box, paste the locus that you copied in step 2, then click Go. 

 
10. Use the tools in the top right of the screen to expand and shrink the view of the tracks. 

 
11. In the Sequence pane, view the direction of the transcript and place the pointer over an exon of interest 

to view more details. 

 
For more information about IGV, see the IGV User Guide. 

https://genome.ucsc.edu/
https://software.broadinstitute.org/software/igv/UserGuide
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System Requirements  
Genexus™ Software 6.6 has a browser-based interface that can be viewed using Google™ Chrome™ version 90 
and above (version 90 has been tested) and is best viewed with a  
1440 x 900 screen resolution. The software is accessed on an independent client computer with a private web 
server. 

Package and version information 

Release Date 28 October 2021 

Release Version 6.6 

 

Software packages versions in 6.6 
These tables list the versions for each of the latest packages and plugins for Genexus™ Software. 

Packages 

Package Version 

ts-algorithm-516 6.6 

ts-apache2 6.6 

ts-assaydev-ampliseq-coca-541-v4 6.6 

ts-assaydev-ampliseq-coca3b-541-v2 6.6 

ts-assaydev-ampliseq-coca3b-gx7-v1 6.6 

ts-assaydev-ampliseqhd-coca-541-v4 6.6 

ts-assaydev-ampliseqhd-coca3b-gx7-v1 6.6 

ts-assaydev-analysis516 6.6 

ts-assaydev-assets 6.6 

ts-assaydev-crawler 6.6 

ts-assaydev-factory-template 6.6 

ts-assaydev-genxscriptupdates 6.6 

ts-assaydev-grws 6.6 

ts-assaydev-igvservlet 6.6 

ts-assaydev-iruploader 6.6 

ts-assaydev-manager 6.6 

ts-assaydev-ocrp516 6.6 
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Package Version 

ts-assaydev-ovat-plugin516 6.6 

ts-assaydev-purificationscriptupdates 6.6 

ts-assaydev-reportbuilder 6.6 

ts-assaydev-seeddata 6.6 

ts-assaydev-server516 6.6 

ts-assaydev-ui 6.6 

ts-config 6.6 

ts-deeplaser 6.6 

ts-fonts 6.6 

ts-genxupdates 6.6 

ts-immune-repertoire 6.6 

ts-java11 6.6 

ts-postgresql 6.6 

ts-purificationupdates 6.6 

ts-reference-delta 6.6 

ts-software-update 6.6 

ts-tomcat8 6.6 

ts-variome-data-calculator 6.6 

 
Plugins 

Plugin Version 

customersupportarchive 6.6 

coverageanalysis 6.6 

molecularcoverageanalysis 6.6 

sampleid 6.6 
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The information in this guide is subject to change without notice. 

For Research Use Only. Not for use in diagnostic procedures. 

DISCLAIMER 
TO THE EXTENT ALLOWED BY LAW, LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) WILL NOT BE LIABLE FOR 
SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH 
OR ARISING FROM THIS DOCUMENT, INCLUDING YOUR USE OF IT.   

Important Licensing Information 
The products may be covered by one or more Limited Use Label Licenses. By use of these products, you accept the terms 
and conditions of all applicable Limited Use Label Licenses.  

TRADEMARKS  
The trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.  

Bitdefender GravityZone is a trademark of Bitdefender IPR Management Ltd. Kaspersky is a trademark of Kaspersky Labs 
International. NOD32 is a trademark of ESET. Symantec is a trademark of Symantec Corporation. 
 

©2022 Thermo Fisher Scientific Inc. All rights reserved. 
For support visit thermofisher.com/support  
 
3 June 2022 

https://www.thermofisher.com/us/en/home/technical-resources/contact-us.html
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